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## Warning: package 'knitr' was built under R version 3.5.2

1 Workshop goal

Even though this workshop can be attended by complete novices, previous workshops on
PyMOL or UCSF Chimera would be very beneficial.
This ChimeraX session is planned to be an overview of the software (that is still in beta
developmemt) and explore some of the new features implemented for the display of large
molecules and Cryo-EM data.

1.1 Learning objectives

• Launching ChimeraX
• Review ChimeraX interface and tools
• Open a 3D coodinate file directly from RCSB Protein Data Bank
• Move & interact with displayed molecule
• Show/Alter representation as ribbons, surfaces, etc.
• Atom selection
• Save and image
• Display biological assembly
• Close and quit

2 Introduction

UCSF ChimeraX (or simply ChimeraX) is the next-generation molecular visualization program
from the Resource for Biocomputing, Visualization amd Informatics (RBVI), an NIH Biomedical
Technology Research Resource (Goddard et al. 2018).
In the long run it is intended to replace UCSF Chimera (Pettersen et al. 2004) for molecular
graphics visualization. ChimeraX has a new interface and also new capabilities such as
“ambient occlusion lighting” for realistic shadows.
ChimeraX can work with a variety of formats, notably crystallographic data from the Protein
Data Bank and Cryo-EM maps.
ChimeraX exists for the 64 bit operating systems of MacOS, Windows 10 and Linux.
ChimeraX is free for academic use and is available for download at https://www.rbvi.
ucsf.edu/chimerax/download.html but is already installed on the classroom iMacs under the
Macintosh OS.
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3 ChimeraX vs Chimera features

ChimeraX will retain a large number of features and capabilities of Chimera but since the
current implementation is still a “beta relase” (as of this writing it is ChimeraX version 0.5)
many commands and features are only available via line-command only rather than mouse
click interface.

3.1 Features

Citing the web site: Compared to Chimera, ChimeraX has a more modern user
interface, better graphics, and handles large structures much faster.
Although similar in many aspects, ChimeraX is not backward compatible with
Chimera and does not read Chimera session files.

Amongst various improvements and advantages of ChimeraX over Chimera:
1. the fast rendering of large number of atoms
2. interactive ambient occlusion lighting modes
3. fast and robust solvent excluded surfaces

3.2 Missing features

While ChimeraX has several completely new features and other advantages, it
will not substantially replace the functionality in Chimera for quite some time.
It currently has a limited set of features and few user-interface dialogs; most
capabilities are implemented as commands only.

Missing features include a long list detailed on the web site. However “daily builds” of the
application may bring them to life at any time.

3.3 Main difference

One important difference between the two software is that Chimera opens many ancillary,
separate windows as commands are given while ChimeraX functions within a single window
pane. However, embedded windows can be undocked and separated from the main window.
Another difference is that ChimeraX has a built-in browser that can open pages containing
active links to be run within ChimeraX. This is the case in particular for the Tutorials pages.

4 Set-up

If you are using the iMac for the first time you may need to review and update the mouse
button assignment by going to the “Apple” menu at the top left:
Apple > System Preferences... > Mouse

“Standard” setting should be set as follows (if you are right-handed) :

4



UCSF ChimeraX - I - Overview

• Left: Primary Button
• Wheel: Button 3
• Right: Secondary Button

Figure 1: “Verify mouse settings in System Preferences.”

Note: If you are left-handed inverting Left and Right assignments might work better for you.
Note:
TASK

This button will invite you to act on suggested actions as we go along the
workshop.

5 Finding and Launching ChimeraX

5.1 ChimeraX Location

If you are following this workshop live in the classroom, the iMac in front of you has ChimeraX
installed wihtin the /Applications directory.
You can also find ChimeraX by using Spotlight Search: the “magnifying glass” icon on the
top right of the Macintosh screen.
On a Windows computer you would type ChimeraX in the search area next to the Start
button or within a “magnifying glass” text entry, also bottom left, with “Cortna” helper in
Windows 10.
If you are using your own computer ChimeraX can be found in the same way.

5.2 Launch ChimeraX

TASK

If ChimeraX has not launched automatically, double-click on its icon:
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Figure 2: “ChimeraX icon.”

1http://www.rbvi.ucsf.
edu/chimerax/

2https://www.cgl.ucsf.
edu/chimerax/docs/
3http://www.rbvi.ucsf.
edu/chimerax/docs/
user/index.html
4http://www.rbvi.ucsf.
edu/chimerax/tutorials.
html

6 Documentation and help

6.1 Online

ChimeraX documentation can be found online as links from the ChimeraX home page1

within the “Quick Links” section at the top left as:
• Documentation2

• User Guide3

• Tutorials4

6.2 Built-in

The same documentation is available built-in ChimeraX and can be accessed from the Help
menu:

Figure 3: “ChimeraX Help menu.”

Calling this help will open a built-in internal browser that is integrated with ChimeraX. This
is particularly useful for tutorials as commands can be clicked-on directly. However, for this
session please do not open the tutorials.
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7 ChimeraX interface

ChimeraX opens with an all-in one window interface split in 2 main panels accompanied by
toolbars at the top and on the left side.. Many of the

Figure 4: “ChimeraX all-in one window.”

From the web page:
ChimeraX has an all-in-one window interface in which various panels can be
shown, hidden, and repositioned. Panels can also be detached (undocked) from
the main ChimeraX window and subsequently reinserted (docked). The overall
window also contains the main window for 3D graphics, a title bar across the
top, and a status line for transient messages across the bottom. At the bottom
right are small icons*:

- - toggle main window to fill overall window

- or - toggle main window between 3D graphics and Rapid Access.
The Tools > Toolbar > menus can turn on and off the top and side bars for the control of:

• Density Map (not active by default)
• Graphics (top right)
• Molecule Display (top left)
• Mouse Modes for Right Button (vertical, left side)

The Density Map Toolbar controls display of electron density maps
The Graphics Toolbar controls the background color, lightings, sketch outline, image and
movie making.
TheMolecule Display Toolbar controls the display ofatoms, ribbons, surfaces, sticks, spheres,
ball-and-sticks, color atoms by elements, color atoms by chain, and display hydrogen bonds.
The Mouse Modes for Right Button (vertical to the left) provides advanced features to
manipulate the molecular display by allocating functions to the right-mouse button.
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Figure 5: “Tools > Toolbar > menus toggle toolbars on all-in-one window.”

5https://www.rbvi.ucsf.
edu/chimerax/docs/
user/window.html

More information on using the all-in-one ChimeraX window is detailed on the documentation
web page The ChimeraX Window5.

8 Tools menu

The Tools menu is used to engage various options. We just used the menu cascade Tools >
Toolbar > above to toggle the display of the control toolbars within the all-in-one window.
The menu cascade Tools > General > offers important tools that need to be turned on if
they are not yet present.

Figure 6: “Tools > General > menus.”
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In the section below we will turn on the line-command.

8.1 Line command

It is useful to turn on the line-command if it not yet turned on.
TASK

Follow the menu cascade:
Tools > General > Command Line Interface

You should now see a text area at the bottom of the all-in-one window preceded with the
word Command:.

9 Open a 3D structure

In this section we will use a simple example file: 1mbo. Structure and refinement of oxymyo-
globin at 1.6 angstroms resolution (Phillips 1980).
ChimeraX can open a structure in 2 ways:

• directly on the Internet with the command open

• with the menu cascade File > Open... if the file is already saved on your computer.
In both cases you would need to know the PDB ID code of four characters gleaned e.g. from
the PDB site or a publication.

Note: When the structure is loaded, it is presented in a default preset mode that
depends on the number of chains contained within the file (more info below.)

TASK

On the command line type the following: open 1mbo and press Return on your key-
board.

ChimeraX will fetch the file from the Protein Data Bank web site in the cif format and
save it within your Downloads folder by default. On a Macintosh the file will be saved in:
/Users/YOU/Downloads/ChimeraX where YOU is your username. On other operating systems
the file would be saved in a similar way and location.
The structure will be displayed on the left wihtin the molecular graphics panel. On the right
pane, summary information about the structure will be displayed below a reminder of the
command issued.
The summary information will be most useful for complex structures and will display the
name of chains. Here there is only chain A. The citation provided is the primary citation of
structure publication.
Finally, information about number of atoms and bonds are provided.
Here: Opened mmCIF data containing 1601 atoms and 1296 bonds

9



UCSF ChimeraX - I - Overview

Note: The Model Panel will open automatically at the bottom right. It can be
closed by clicking the (x) button and can be “detached” by clicking the other
button. If closed it can be recalled with the menu cascade: Tools > General >
Model Panel. The buttons on the right can affect the model: Close, Hide, Show,
View

TASK

To make your display similar to the following image, simply click the white square
within the Graphics Toolbar at the top right. This will change the background to
white.

Figure 7: “Myoglobin protein in 1mbo opens as ribbons; ligands as sticks. Hovering the mouse over
will reveal amino acid info.”

Important Note: When a button is clicked, its line-command equivallent is
immediately displayed on the right panel.
For the background color change this would have echoed set bgColor white onto
the panel. Note also that the command is highlighted in blue and is a hypertext
link to the help pages. Clicking on such a link will open the ChimeraX internal
browser to display this information.

TASK

Explore briefly the current display.

To rotate the structure: click on the left mouse button and move.
Table 1: Summary of the graphics mouse control

Mouse button Control
left rotate molecule when clicking wihtin the space occupied by molecule
left rotate arounz Z axis when clicking on corners
right upward: zoom out. downward: zoom in
wheel click: translate molecule
wheel rotate wheel to zoom in and out
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6https://www.rbvi.ucsf.
edu/chimerax/docs/
user/autostyle.html

You should easily note the follwoing:
• protein: shown as ribbon
• ligands (heme and SO4) : shown as sticks
• chelated iron ion (FE) : shown as sphere; hydrogen bonds internally and to His and

OXY
• oxygen atoms (OXY) : shown as sticks; hydrogen bonds to FE
• residues within close distance to ligands: shown as sticks.
• a few HOH water molecules: shown as small red spheres.

Important Note: ChimeraX automatically adjusts the appearance and style of the structure,
based rules that take into account the number of chains contained in the structure. For
example for 1mbo there is only one chain and therefore the structure is presented as a ribbon.
This can explain that different structures may be displayed very differently when first opened.
This behavior can be overruled by adding autoStyle false after the open command. However,
this would show the structure only as spheres, without any colors (white atoms.)
In summary:

• 0 chains: sticks
• 1-4 chains: cartoon; sticks for ligands, nucleic acids
• 5-249 chains: spheres (space-filling); sticks for ligands, balls for solvents
• 250+ chains: spheres (space-filling)

The complete rules are listed on the autostyle6 page within the documentation.

10 Graphics toolbar display modes

We’ll first briefly explore the effects of the buttons on the Graphics Toolbar (top right) to
alter the display, lighting and look of the molecule.

Figure 8: “The Graphics Toolbar”

10.1 Background color

The first three square items change the background color. There are more fancy colors that
could be used, but these three choices are the most useful.
The command set bg_color can be used for more dramatic colors (not recommended for
publication!) See next section for color names.

10.2 Light and shadows

TASK

On your own select the next four items. They pertain to lighting and shadows:
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• simple lighting (projector)
• single shadow (shadow)
• soft lighting (cube)
• full lighting (apple)
• flat lighting (gray blob)

Note: the soft and full lighting use ambient occlusion shadows to provide a life-like aspect.
This is a rather modern method and requires light sources from multiple directions. ChimeraX
uses 64 lights by default, reduced to only 16 for structures that are very large (more than 250
chains.)

10.3 Edges outline (silhouettes)

When you press the “flat” lighting (gray blob) button, you may note that there is a slight
black outline on the edges of the drawing. This is controlled by the next button “Silhouette
edges” that looks like a hippocampus (9th button from the left.)

Figure 9: “The Flat lighting and Silhouette edges buttons”

TASK

• Click on the “flat” lighting button
• Then click on the “Silhouette edges” button

Note how the outline disappears and makes the molecule contours harder to discern.
The silhouette can be further altered by line command, for example to change the color or
the width of the outline.
TASK

Change the silhouette defaults with the following commands:

• set silhouettes true : this is equivallent to clicking on the “Silhouette edges” button
• set silhouetteWidth 5 : this changes the width of the line
• set silhouetteColor blue : this change the color of the line

In some cases, these kind of setting for both silhouette and flat lighting can provide “artistic”
depictions.

Note: There are many colors built-in ChimeraX (currently 248 colors are defined.)
The name of the colors can be listed with the command: color list or color
list builtin. This will show a small square of color followed by the color name.

10.4 Change molecule color

The “Model Panel” (described above) is useful for selecting all or portions of the molec-
ular display (more on that later) but also provides an easy way to alter the color of the
representation(s).

12
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Figure 10: “Artistic depiction?”

Figure 11: “Output of command color list.”

The small, colored squares represent the current color of the described item. Clicking on any
of those squares will open a color editor where color can be altered.
TASK

Change the ribbon color: click on the brown square to open color editor.

10.5 Orientation, snapshot and movie

The last four buttons of the Graphics Toolbar have the following name:
• View all.
• Standard orientation.
• Save snaphot to desktop.

Figure 12: “Model Panel window after automatic initial display.”
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Figure 13: “Color editor.”

• Record spin movie.

Figure 14: “Last 4 buttons of Graphics Toolbar.”

View all will “shrink” (zoom out) the size of molecules so that all fit within the molecular
graphics panel. There is no rotation involved.
Standard orientation will reorient the molecule to the position where it was first opened.
Save snaphot to desktop will save a .png image of the current molecular graphics panel,with
the same dimensions, directly onto the desktop for easy finding. All options will be default
options, such as the smoothing of lines.
Record spin movie will save a movie of 180 frames in .mp4 format with a 360 degrees
rotation (hence 2 degrees increment.) The file is also saved directly onto the desktop.
TASK

On your own try these four buttons and note the equivallent commands displayed
onto the right panel.

This is what you should see: 1 line each for the first 3 buttons, and 4 lines for the movie
button.

14
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Figure 15: “Commands echoed on right panel.”

11 Molecular display toolbar

11.1 Restart

For this section it is best to quit and restart ChimeraX to ensure that everything is reset and
facilitate the next exercises.
TASK

Quit and restart ChimeraX

Note: as you restart you may note that a mini representation of the previously
opened molecule(s) is visible within the left panel.

The “lightning” icon at the bottom right of the The ChimeraX Window will toggle on/off
between the 3D molecular graphics (left panel) and the Rapid Access display showing mini
representations of previously opened molecules.
If you have not opened any other molecule there will only be one for 1mbo present.
TASK

Reopen 1mbo by clicking on the Rapid Access square representation

The ChimeraX window will now show the molecule again in the default view.

11.2 Molecular display toolbar buttons

The molecular display toolbar will alter, show or hide the follwing representations: atoms,
ribbons, surface, stick, sphere, ball-and-stick, atom color by element, atom color by chain,
and hydrogen bonds.

15
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Figure 16: “Rapid Access square representation.”

Figure 17: “Molecular display toolbar. Atoms, ribbon, surface etc.”

The name of the Molecular display toolbar can be seen by hovering the mouse over each
button:

• Show atoms
• Hide atoms
• Show molecule ribbons
• Hide molecule ribbons
• Show molecular surface
• Hide molecular surface
• Show molecule in stick style
• Show molecule in sphere style
• Show molecule in ball and stick style
• Color atoms by elements
• Color atoms by chain
• Show hydrogen bonds

It is important to remember that the 3D coordinate file will contain ATOM records for protein
and nucleic acid atoms, and HETATM records for “heteroatoms” i.e. atoms that are other than
protein and nucleic acid. These are usually ligands, solvents, metal ions, and water molecules.
During the default view display, ChimeraX will recognize these distinctions and prepare the
protein as a ribbon (depending on number of chain present, see above.) Then it will show
ligands as sticks, ions as spheres, and amino acids close to ligands also as sticks. This is what
we see here for the default display of 1mbo.
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We are now going to alter, hide or show various representations. However, we shall NOT
start with the atom buttons (the first 2 buttons.)
TASK

Click button on the Molecular display toolbar but NOT the first two (Show/Hide
atoms) for now!

It is better if you click in the order from left to right (again, NOT touching the first 2.)
The table below summarizes what you should see if you click the buttons from the molecular
display toolbar in the order they appear on the bar (except the first 2.) The result is also
linked to which atoms are currently selected (see next section.)

Table 2: Table summarizing what you should see

Click on button See this
Show molecule ribbons Nothing will change as the ribbon is already visible!
Hide molecule ribbons Ribbon disapears. Only sticks (ligands and close amino

acids) and sphere (ion) will remain.
Show molecular surface Molecular suface will show for protein. Ligands are outside

of surface as sticks.
Hide molecular surface Surface disapears. Only sticks (ligands and close amino

acids) and sphere (ion) will remain.
Show molecule in stick style Ion sphere becomes small sphere. No other changes
Show molecule in sphere
style

Ligands and close amino acids, water molecules shown as
spheres.

Show molecule in ball and
stick style

Ligands and close amino acids, water molecules shown as
ball and sticks.

Color atoms by elements No change. Already colored that way.
Color atoms by chain All become the same color (purple) as there is only one

chain.
Show hydrogen bonds Add H-bonds to visible ball-and-stick models

11.3 Show and hide atoms

Note: Here it may again be useful to quit, restart, and reopen 1mbo.
When a molecule is first open, as already mentioned above, ChimeraX creates an intial
display based on Automatic Styling sometimes referred as Smart Initial Display.
However, as soon as one uses the “Show atoms” and “Hide atoms” buttons this display is
altered in a way that is not easily reconstructed without knowing more about ChimeraX.
This behavior is related to the current selection of atoms as understood by ChimeraX.
One easy method is to quit and restart.
Another method is to toggle off the right-hand panel with the bottom right toggle button

. However, this would open a second version of that molecule and the “Model Panel”
could then be used to close the first to reveal the newly opened molecule.

17



UCSF ChimeraX - I - Overview

7http://www.rbvi.ucsf.
edu/chimerax/docs/
user/selection.html
8http://www.rbvi.ucsf.
edu/chimerax/docs/
user/commands/select.
html
9http://www.rbvi.
ucsf.edu/chimerax/
docs/user/commands/
atomspec.html

11.4 Atom selection

11.4.1 Definitions

Which atom(s) are currently selected will determine the effect of many buttons (e.g. on
Molecular display toolbar) or command lines.
While selected atoms will appear highlighted in green outlines on the graphics window, there
are sometimes “internal” selection that occur as we experienced with the “Atom display”
earlier.
Selection can be accomplished by line command, or by mouse click or drag. The help pages
on selection7 and the select8 command offer a more complete description.
The line command selection itself relies heavily on the atom specification9 to designate
complete models, chains etc.
When a molecule is opened, it is given a model number. This number appears also within the
“Model panel” (see above.)
The following summary table shows the “hierachical specifiers” for models, chains and atoms
(simplified from the atom specification page.)

Table 3: Table listing “hierarchical specifiers”" for atom specification

Symbol Reference Level Definition Examples
# model model number assigned in ChimeraX #1 #1.3

/ chain chain identifier /A

: residue residue number OR residue name :51 :glu

@ atom atom name in PDB file @ca @nz

The atom specifications can be combined; here are a few examples from the atom specification
page:

Table 4: examples of atom selection by hierachical specifiers

Example Meaning
#1 all atoms in model 1
#1/B-D,F chains B, C, D, and F in model 1
#1,2:50,70-85@ca atoms named CA in residues 50 and 70-85 in

models 1 and 2
/a,d-f:43-256 residues 43-256 in chains A, D, E, and F
:12-25,48@ca,n atoms named CA and N in residues 12-25 and 48
:lys,arg lysine and arginine residues
:lys,arg@cb atoms named CB in lysine and arginine residues

There are many more examples, including much more complex examples on the atom specifi-
cation page.
TASK

Use the select command with a definition above to color the first 18 amino acides
of 1mbo.
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10https://pdb101.
rcsb.org/learn/
guide-to-understanding-pdb-data/
biological-assemblies

On the command line type the following commands:
• sel #1:1-18

• sel is short for select - this will select amino acides 1 through 18 for model 1. On the
display the selection will be highlighted by a surrounding green outline.

• color sel yellow (this will color the selection yellow.)
• To release the selection: Ctrl-Click the left button anywhere on the background.

Figure 18: “Select and color with selection command.”

11.4.2 Built-in classifications; atoms and heteroatoms

Interestingly, there is no built-in command for selecting all “heteroatoms” (HETATM records; if
you are familiar with PyMOL the selector in that software is hetatm.)
However, ChimeraX offers a range of useful premade selectors referred to as “classifications.”
(See middle section of atom specification page.)

11.5 Models

Every time a molecule is opened, it is given a model number and shows as an entry in the
“Model Panel” (See image above in section Change molecule color.)
The model number appears under the column ID while column S means “Show” and can be
use to hide the structure.

12 Biological Assembly

12.1 Coordinates files

The PDB files solved by X-Ray crystallography contain the solution to sloving the “asymetric
unit” i.e. the smallest portion of the crystal necessary to reconstruct the whole crystal by
symmetry. However, that does not necessarily reflect the biologically active form, monomeric
or multimeric form of the biologically functional assembly.
A biological assembly may be built from10:

• one copy of the asymmetric unit

19

https://pdb101.rcsb.org/learn/guide-to-understanding-pdb-data/biological-assemblies
https://pdb101.rcsb.org/learn/guide-to-understanding-pdb-data/biological-assemblies
https://pdb101.rcsb.org/learn/guide-to-understanding-pdb-data/biological-assemblies
https://pdb101.rcsb.org/learn/guide-to-understanding-pdb-data/biological-assemblies
http://www.rbvi.ucsf.edu/chimerax/docs/user/commands/atomspec.html


UCSF ChimeraX - I - Overview

• multiple copies of the asymmetric unit

• a portion of the asymmetric unit
The coordinate file (which will be downloaded automatically) will contain information for the
rotational and translational transformations to build a biological assembly. This takes form as
a 3x4 (rotation/translation) matrix.
If the file format is .pdb the matrices will be listed in the REMARK 350 entries in the header.
For example, the PDB file 1DUD is a monomer as an asymetric unit, but a trimer as a biological
assembly. Three matrices, including the identity matrix will be provided:
[...]

REMARK 350 APPLY THE FOLLOWING TO CHAINS: A

REMARK 350 BIOMT1 1 1.000000 0.000000 0.000000 0.00000

REMARK 350 BIOMT2 1 0.000000 1.000000 0.000000 0.00000

REMARK 350 BIOMT3 1 0.000000 0.000000 1.000000 0.00000

REMARK 350 BIOMT1 2 -0.500000 -0.866025 0.000000 43.32000

REMARK 350 BIOMT2 2 0.866025 -0.500000 0.000000 75.03244

REMARK 350 BIOMT3 2 0.000000 0.000000 1.000000 0.00000

REMARK 350 BIOMT1 3 -0.500000 0.866025 0.000000 -43.32000

REMARK 350 BIOMT2 3 -0.866025 -0.500000 0.000000 75.03244

REMARK 350 BIOMT3 3 0.000000 0.000000 1.000000 0.00000

If the file is downloaded as the newly used CIF format (.cif) the matrices in the header
will follow some loop_ definitions such as _pdbx_struct_assembly_prop.biol_id and
_pdbx_struct_oper_list.symmetry_operation amongst many others. The matrices will not
appear as neatly organized to the human eyes (!) without the presentation in columns:
[...]
_pdbx_struct_oper_list.matrix[3][3]
_pdbx_struct_oper_list.vector[3]

1 'identity operation' 1_555 x,y,z 1.0000000000 0.0000000000 0.0000000000 0.0000000000 0.0000000000

1.0000000000 0.0000000000 0.0000000000 0.0000000000 0.0000000000 1.0000000000 0.0000000000

2 'crystal symmetry operation' 2_665 -y+1,x-y+1,z -0.5000000000 -0.8660254038 0.0000000000 43.3200000000 0.8660254038

-0.5000000000 0.0000000000 75.0324409839 0.0000000000 0.0000000000 1.0000000000 0.0000000000

3 'crystal symmetry operation' 3_565 -x+y,-x+1,z -0.5000000000 0.8660254038 0.0000000000 -43.3200000000 -0.8660254038

-0.5000000000 0.0000000000 75.0324409839 0.0000000000 0.0000000000 1.0000000000 0.0000000000

In the next section we’ll briefly review how ChimeraX allows the display of either ver-
sions,asymetric unit or biological assembly, for 2 common cases.

12.2 1DUD trimeric assembly

The first example will show how to create a the biological assembly, a trimer, from the single
monomeric structure structure (asymetric unit) contained within the coordinate files. As
stated above the file will contain the necessary information to build the biological assembly.
This structure is an Escherichia coli dUTPase in complex with a substrate analogue (dUDP)
(Larsson, Svensson, and Nyman 1996).
TASK

20



UCSF ChimeraX - I - Overview

Close all models (e.g. with the close button on the Models Panel, or restart. Then
open structure 1dud.

• To open the structure type command: open 1dud. You will see a single ribbon structure.
• To inquire about possible symmetrical constructions, type command sym #1 (assuming

model #1 contains that structure.)
Since there is only one solution the following table will appear with one entry:

Figure 19: “Symmetry information output”

The solution is a trimer of chain A as specified in the last column.
• Create biological assembly with command: sym #1 assembly 1. This request that

symmetry be applied to model 1 (#1) to create the assembly versio 1 (which in this
case is the only one described within the file.)

Figure 20: “Trimeric assembly of 1dud.”

Note: that the Models Panel now contains 2 entries:
• 1dud with ID of 1 - which is now hidden (Show button is off)
• 1dudassembly1 with ID of 2, which is shown.
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Note: it is possible to request that the biological entity be part of the same model
by adding newmodel false. The above command could be re-written as: sym #1

assembly 1 newmodel f

12.3 2BIW monomer

2BIW contains the Crystal structure of apocarotenoid cleavage oxygenase from Synechocystis,
native enzyme (Kloer et al. 2005).
The asymetric unit consists of 4 monomers of the enzyme while the biological assembly
consists of only one monomer. Therefore the coordinates file contains four times the amount
of information relevant to the biologist.
Currently ChimeraX will download the complete coordinates file, and the user will call the
biological assembly as we have done above.
For this structure
TASK

Close all models (e.g. with the close button on the Models Panel, or restart. Then
open structure 2biw.

• open 2biw

• optionally click on the top bar button to “color atoms by chain” (11th button
from the left on the molecular display toolbar.)

• Call symmetry options with sym #1 (change 1 to the model number if diferent.) As we
established above there are 4 monomers, each of of them is a biological assembly.

Figure 21: “Symmetry information output”

We’ll display only the second one, and hide the others, and keep everything within the same
model:

• sym #1 assembly 2 newmodel f

However, it may be easier (as in the previous example) to let ChimeraX create a new model,
as just clicking on the “show ribbon button” (3rd button from the left on the molecular display
toolbar) will show all monomers again!
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Figure 22: “Four monomers of 2biw make the asymetric unit.”
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